
 

 
Disclaimer:  Configuration Notes are designed to be a general guide reflecting AVAYA Inc. experience configuring its systems.  These 
notes cannot anticipate every configuration possibility given the inherent variations in all hardware and software products. Please 
understand that you may experience a problem not detailed in a Configuration Note.  If so, please notify the Technical Assistance 
Center at (800) 876-2835, and if appropriate we will include it in our next revision.  AVAYA Inc. accepts no responsibility for errors or 
omissions contained herein. 
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1.0 METHOD OF INTEGRATION 
With Inband integration, one pathway between the Avaya Merlin Legend™ and the 
Avaya Message Application Server (MAS) transmits both call information and 
voice communications.  The pathway is provided by 2-wire analog single-line 
circuits that connect to Dialogic cards in the MAS.  Each Dialogic port simulates 2-
wire analog lines.  Calls to the MAS ports are preceded by the called party 
information from the PBX in DTMF format.  The MAS then answers and plays the 
appropriate greeting.  Message-Waiting indication is set and canceled using DTMF 
commands over the same pathway. 

2.0 AVAYA MESSAGE APPLICATION SERVER REQUIREMENTS 
• Dialogic D/41JCT-LS or D/120JCT-LS cards (4 and 12 port/cards) 

• Releases 1: 1.1, 2.0, 3.x, 4.0, 5.x 

3.0 PBX HARDWARE REQUIREMENTS 
• Station appearances, one per MAS port 

• Analog Interface Card (012 or 016 card port). 
• A ring generator unit (Pec Code 61388A) is required to provide ring voltage 

to the MAS ports if using 012 SLT cards, model 517 A13 through 517 F13 
• CPU at Release 2 or higher 

A v a y a  

M o d u l a r  M e s s a g i n g  

With Inband integration, 
one pathway between the 

PBX and the Avaya 
Message Application Server 

transmits both call 
information and voice 

communications 

MAS requirements 
1 Release Note:  

Should features of the integration not 
function optimally when integrated to a PBX 

or MM that may be operating on an 
unsupported software release as defined 

Section 2.0 and 3.1, customers will need to 
upgrade their PBX and/or MM to a 

supported software release. 

PBX hardware requirements 
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NOTE: Depending upon the size of the MAS, additional Touch Tone (DTMF) 
Receivers might be necessary.  Use Table 1 as a guideline for determining your 
requirements. 

 

Number 
of MAS

ports

1

2

3

4

6

8

12

Number
of 012 or 016

modules

1

1

1

1

2 or 1

2 or 1

3 or 2

Number of 400 or
400 GS/LS/TTR

modules

0

0

0

0

0 or 1

0 or 1

0 or 1

Number of  
TTRs needed 

1 

1 

2 

2 

3 

4 

6 

Table 1 - DTMF Receiver

 
• Cables: 

- RJ11 four-wire telephone cord, one per MAS port 

NOTE: The customer must provide the necessary hardware. 

3.1 PBX SOFTWARE REQUIREMENTS 
• Minimum Software 1 (see pg 1):  R2V1 

• Hybrid/PBX configuration (see section 8.2) 

4.0 SUPPORTED INTEGRATION FEATURES 
[ ] Items are supported 
 
System Forward to Personal Greeting 
 All Calls [ ] 
 Ring/no answer [ ] 
 Busy [ ] 
 Busy/No Answer [   ] 
 
Station Forward to Personal Greeting 
 All Calls [   ] 
 Ring/no answer [   ] 
 Busy [   ] 
 Busy/No Answer [   ] 
 
Auto Attendant [ ] 
Call Me [ ] 
Direct Call [ ] 

PBX software requirements 

Supported integration features 
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External Call ID (ANI) [   ] 
Find Me [   ] 
Internal Call ID [ ] 
Message Waiting [ ] 
Multiple Return to Operator [ ] 
Multiple Call Forward [ ] 
N+1 [   ] 
Outcalling [ ] 
 
IMPORTANT: PBX options or features not described in this Configuration 
Note are not supported with this integration.  To implement options/features not 
described in this document, please contact the Avaya Switch Integration product 
manager. 

5.0 CONFIGURING THE LEGEND TO INTEGRATE 
Programming on the Legend can be done using a system programming console 
or a personal computer with System Programming and Maintenance software.  
With both methods, the screens seen while programming are identical.  For 
details, refer to the Avaya Merlin Legend Communications System 
Programming Manual.  

� Once you are logged into the Legend system, the System Programming 
 menu will appear as follows: 

System Programming :

Make a selection

System Extensions

SysRenumber Options

Operator Tables

LinesTrunks AuxEquip

Exit NightSrvce>

System Programming Menu  

 
� The Legend system must be configured as a Hybrid/PBX.  This 
 programming must be done when the system is idle.  In addition, this 
 programming will cause the system to restart when you are finished.  
 Therefore, choose an appropriate time for this procedure. 

• From the System Programming menu, select System. 

• From the System menu, select Mode. 

Configuring the Legend to 
integrate with the MAS 

The Legend system must be 
configured as a Hybrid/PBX 
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• Within the Mode menu, select Hybrid/PBX. 

• To save your selection, press enter. 

• At this point, the system will restart as noted above.  To continue 
programming, re-enter system programming. 

� If necessary, install 012 or 016 analog ports for the MAS.  One analog 
port is required for each MAS port. 

� Program the Voice Mail System/Automated Attendant Options as 
 follows: 

• From the System Programming menu, select AuxEuip, to reach the 
Auxiliary Equipment menu. 

• From the Auxiliary Equipment menu, select VMS/AA. 

• From the VMS/AA screen, select TransferRtn.  This parameter, 
Transfer Return, represents the number of rings before calls 
transferred by the MAS are sent to a designated backup position.  Set 
it to “0” to disable this feature.  If supervised transfer applications 
are used, this parameter should be disabled. 

• From the VMS/AA screen, select TT Duration.  This parameter 
should be set to 75 (milliseconds).  If it is not, erase the current 
setting (using the Drop key) and enter 75.  Press enter to save your 
entry. 

• From the VMS/AA screen, select TT Interval.  This parameter 
should be set to 50 (milliseconds).  If it is not, erase the current 
setting (using the Drop key) and enter 50.  Press enter to save your 
entry. 

• Press exit twice to return to the System Programming menu. 

� Create a calling group for the MAS ports: 

• From the System Programming menu, select Extensions. 

• Display the second page of the Extensions menu using the More key 
on the console (on a PC use the PgUp key). 

• From the Extensions menu select Group Calling. 

• From the Group Calling menu, select Hunt Type. 

• Enter an extension number to be assigned to the calling group.  Then 
press enter to save your entry.  This number will be the MAS System 
Access Number. 

Program the Voice Mail 
System/Automated Attendant 

Options 

Create a calling group for the 
MAS ports 
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• The next screen asks you to select the hunt type.  Choose Circular. 

• Press exit to return to the Group Calling menu. 

� Assign the MAS ports as members of the calling group:  

• From the Group Calling menu, select Members. 

• Next, enter the extension number just assigned to the MAS calling 
group.  Press enter to save your entry. 

• At the “Enter group members” prompt, specify the first MAS port 
with one of the following: 

-extension number nnnn (will be 2, 3, 4 digits, etc.) 

-slot and port number *sspp 

-logical ID number #nnn 

• If the MAS ports are in sequential number, press the Next key to add 
the next MAS port. I f the MAS ports are not sequential, press Enter 
to add the next MAS port.  Repeat until all MAS ports have been 
added to the calling group. 

• When all MAS ports have been added, verify your entries by using 
the Inspect key on the console.  (If you are using a PC to program 
the Legend, press PgDn and then the F5 key.)  This will list all 
members of the calling group. 

• Press exit to return to the Group Calling menu. 

� Assign the Group Type for the MAS calling group.  This parameter  tells 
 the Legend to send mailbox ID information on calls to the MAS 
 system.  In addition, it will automatically log in the MAS ports after a 
 power failure. 

• At the Group Calling menu, select More to see the second page of 
the menu. 

• From the Group Calling menu, select Group Type.  

• Enter the extension number of the MAS calling group.  Press enter 
to save your entry.  

• At the next screen, select Integ VMI. Press enter to save your 
selection. 

• To return to the Extensions menu, press exit twice. 

Assign the MAS ports as 
members of the calling group 

Assign the Group Type for the 
MAS calling group 
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� Program the MAS as the call coverage target: 

• Use the More key to reach the second page of the Extensions menu. 
Then, select Group Cover. 

• Enter a number from 1 to 30 as the coverage group number for the 
MAS.  Press enter. 

• When prompted for extension numbers, enter only the extension 
number assigned to the MAS calling group.  Press enter. 

• To return to the System Programming menu, press exit twice. 

� Program the Group Coverage Delay Interval.  This is the number of  rings 
after which the Legend will send calls to the MAS server. 

Note: This setting is for Release 4.0 and earlier systems.  This is not 
applicable to Release 4.1 or higher. 

• From the System Programming menu, select Options. 

• Use the More key to reach the second page of the Options menu.  At 
this screen, choose Group Coverage Delay Interval. 

• Erase the current entry using the Drop key.  Now specify the 
number of desired rings, from 1 to 9. Press enter. 

• To return to the System Programming menu, press exit. 

� To assign the call coverage to the MAS subscribers, perform the 
 following programming: 

• From the System Programming menu, select Extensions. 

• Use the More key to reach the second page of the menu. At this 
screen, choose Group Cover. 

• Enter the Group Coverage number (1 to 30) previously created, 
containing the MAS Calling Group extension number. 

• Next, enter the subscribers’ extension numbers. 

� To assign trunks to be answered directly by the MAS system, perform 
 the following programming: 

• From the System Programming menu, select Extensions. 

• Use the More key to reach the second page of the menu.  At this 
screen, choose Group Calling. 

• At the Group Calling menu, select Line/Pool. 

Program the MAS as the call 
coverage target 

To assign trunks to be 
answered directly by the MAS, 

perform the following 
programming 
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• Next, enter the MAS calling group extension number.  Press enter. 

• At the “Enter line/pool numbers” prompt, identify the trunk or trunk 
pool that you want the MAS to answer.  This can be done in one of 
three ways: 

-Line or trunk number nnn 

-slot and port number *sspp 

-logical ID number #nnn 

• To return to the System Programming menu, press exit three times. 

 

Message waiting indicators are set and canceled by dialing a feature access code 
followed by the extension number. 
 
Message Waiting Parameters 
Permit Message Waiting Lights   
Message Waiting Light Prefix ON #53 
Message Waiting Light Prefix OFF #*53 
 

� To save this added System Programming, select System, then select 
Back/Restore. 

6.0 CONFIGURING THE MESSAGE APPLICATION SERVER 
 
Configuring the MAS platform for proper PBX integration requires 
configuring several containers accessed within the Voice Mail System 
Configuration application, and a certified MM engineer. 
 
 Access the Voice Mail System Configuration application from the 

MAS program group.  Expand all fields so all-applicable options are 
visible. 

1. Select the Voice Mail Domain 
2. Expand PBXs 
3. Select the newly created Dialogic Avaya G3 Inband 
4. Access the General (Dialogic analog) PBX Configuration tab 
5. Go Off Hook when Port Disabled = Enable by checking the box 
6. Pause before Digits (ms) = 100 
7. Pause Interval for Comma in Dial String (ms) = 2000 
8. DTMF Inter-Digit Delay during Dialing (ms) = 80 

Configuring the MAS 
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9. DTMF Length during Dialing (ms) = 80 
10. DTMF Length during Detection (ms) = 50 

 Next access the Transfer/Outcall tab 

1. Transfer Mode = Blind 
2. Transfer Prefix Code = &,XN 
3. Transfer Completion Code = Leave Blank 
4. Transfer Release Code when Busy = & 
5. Transfer Release Code when No Answer = & 
6. Transfer Release Code when Reject = &,& 
7. Flash Time Interval (ms) = 500 
8. Enable Call Progress = Enable by checking the box 
9. Start Delay for Call Progress (ms) = 1000 
 

 Next access the Hangup Detection tab 
1. Maximum Continuous Tone before Hanging Up (ms) = 6000 
2. Hangup String = Leave Blank 
3. Hangup String Timeout (ms) = 0 
4. Minimum Duration For Drop in Loop Current (ms) = 300 
5. Maximum Silence before Hanging Up (ms) = 6000 
6. Select OK to save changes 

 Select Voice Server and access Telephony Interface (Dialogic 
Analog) 
1. Select the Analog tab 
2. Playback Volume = 2 
3. Number of Ports = Enter the number of ports in your system 
  Note: The MAS service must be restarted to allow port enabling 

4. Enable each Port by checking the checkbox next to the Port field 
5. Extension = Enter the proper extension number assigned to each port 
6. Incoming Ring Count = 1 
7. Primary ID = Leave Blank 
8. Secondary ID = Leave Blank 
9. Select OK to save changes 

 Next access PBX Integration 

1. Select the General tab 
2. Click on Inband to set as the Integration Type 
3. Access the Inband tab 
4. Maximum Inter-digit Gap (ms) = 500 
5. Pause before Inband Digits (ms) = 2000 
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6. DTMF On Time (ms) = 80 
7. Search Entire String for Reason Code = Leave blank 
8. Location of Inband reason code = 1 
9. Log Inband Packets = Leave blank 
10. Fixed Length Packets = Leave blank 
11. Filler Character = <None> 
12. Delimiter Character = # 
13. Right Alignment of Digits in a Field = Leave blank 
14. Request String Supported = Leave blank 

 Access the Protocol Settings button within the same tab 

1. Call Packet Type = Direct Call 
2. Codes for Call Type: 

Code 1 = 00 
3. Field Type Settings: 

- Called Id = Leave blank 
- Calling Id = 2 (Under the Sequence Number column) 
- Trunk Id = Leave blank 

4. Next select Call Packet Type = Divert: 
5. Codes for Call Type: 

Code 1 = 02 (Internal call routing for All Call) 
Code 2 = 03 (External call routing for All Call) 

6. Field Type Settings: 
Called Id = 3  (Within the Sequence Number column) 
Calling Id = 2  (Within the Sequence Number column) 
Trunk Id = Leave blank 

7. Select OK to save changes 

 Within the Inband tab, access the MWI Settings button 

1. Port Group Name = Select the port group to be used for MWI 
2. Max. MWI Sessions = Enter the maximum number of MWI sessions 

allowed at one time.  The Default value is 1 
3. Indicator On/Off signals must use same port = Click to turn on 
4. Indicator On:      Prefix = #53     Suffix = Leave blank 
5. Indicator Off:      Prefix = #*55  Suffix = Leave blank 
6. Select OK to save changes 
 

Note: The numeric values of #53 and #*53 for MWI on/off shown above are 
examples. Confirm what the MWI Feature Access Codes for these 
specific settings are on your PBX. The settings in the PBX for MWI 
on/off must match those for MWI on/off in the MM. 

 
After making these changes, return to “Configuring the voicemail system” within 
the Message Application Server Installation Guide.  Ensure you are prompted to 
restart the Message Application Server services to apply these changes. 
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8.0 CONSIDERATIONS/ALTERNATIVES 
8.1 The Legend does not provide consistent disconnect signaling.  As a 

result, it might be necessary for the MAS to rely upon silence detection to 
disconnect when callers hang up.  Silence detection might take up to 30 
seconds to disconnect.  Caller prompting and subscriber training are 
recommended to encourage callers and subscribers to exit the MAS 
completely when finished. 

8.2 The Legend must be programmed as a hybrid/PBX for integration.  
 Integration is not currently supported for Legend systems configured as 
 key systems. 

8.3  With release 1 software, stations on the Legend cannot all-calls 
forward to the pilot number of a calling group (hunt group).  The do-
not-disturb feature on the Merlin Legend is suggested as an alternative.  
This feature when activated at a station will suppress the ringing of 
incoming external calls.  External calls will then follow any call coverage 
programmed for that station.  Internal callers will receive busy tone when 
dialing a station in do-not-disturb and will not follow call coverage 
programming.  Release 2 software will allow all-calls forwarding to the 
voice-processing module. 

Important notes regarding 
this integration 
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CHANGE HISTORY 

Revision Issue Date Reason for Change 

DRAFT 0.1 11/20/02 Initial release for review/validation 

DRAFT 0.2 03/14/03 Brand name changes 

Version A 03/28/03 GA 

Version B 12/17/03 Updated to meet Release 1.1 

Version C 07/13/04 Change the PBX Type from Dialogic Avaya Merlin 
Legend/Magix to Dialogic Avaya G3 

Version D 09/16/04 Updated to meet MM 2.0 

Version E 12/06/04 Updated Pause Before Digits from 2000 ms to 100 ms as per 
RTO findings. 

Version F 04/11/06 Updated to meet release MM 3.0 

Version G 06/01/07 Updated Inband Tab/MWI Settings at end of Section 6.0. Made 
note red. 

Version H 05/05/08 Updated to support MM 4.0 

Version I 05/16/08 Updated diagram page 1 

Version J 2/02/09 Updated to support MM 5.0 

Version K 07/09 Updated to support MM 5.1 

Version L 01/19/10 Added note indicator to titles of Section 2.0 and 3.1; added 
corresponding note in sidebar; removed word “supported” in 
same sections for MAS releases and PBX Software releases. 
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